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FactLook lets you quickly and easily transform raw data into stunning, 
thematic maps at a fraction of the cost of similar software products. This 
manual will help you quickly start building maps, provides info about the 
software’s features and functions, and offers guidance should you have 
questions or need support.
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Introduction

Browser / Technical Requirements

FactLook is a dynamic web-based application. 
You will need a suitable internet connection in order 
to use the application. FactLook works best on the 
following browsers:

•   Chrome   •   FireFox   •   Safari

Registering to use FactLook

To use FactLook you’ll first need to choose a pricing 
plan and register. You will need to have a valid credit 
card and an active email address that you can use to 
validate your registration request.

From the home page, choose “Register”, or go to 
the Pricing page and choose the plan that fits your 
needs. After completing the payment process, you 
will be redirected to the sign in page for access to 
your account.

Plans & Pricing

FactLook offers three subscription-based pricing 
plans: Basic, Standard and Pro. All plans renew each 
month automatically unless you choose to cancel the 
subscription. The credit card you use to sign up will 
automatically be charged each month.

Basic
Your spreadsheet has just a few hundred rows of data. 
Our Basic plan is the way to go.

• 2000 datapoint credits per month allowance
• Unlimited map templates
• $15 per month
• Additional datapoint credits can be purchased in 

packages of 2,000 for $10 each

Standard
Choose Standard if you work with spreadsheets with 
hundreds of rows of data and plan on updating your 
maps a few times each month.

• 10,000 datapoint credits per month allowance
• Unlimited map templates
• $35 per month
• Additional datapoint credits can be purchased in 

packages of 2,000 for $10 each

Pro
Working with spreadsheets with thousands of rows 
of data or metrics and plan on making multiple new 
maps each month? Go Pro for the best value.

• 40,000 datapoint credits per month allowance
• Unlimited map templates
• $120 per month
• Additional datapoint credits can be purchased in 

packages of 2,000 for $10 each

Which plan is the best for you?

Short answer: Look at your spreadsheet(s) and add up 
the number of rows of data. The total number of rows 
equals the number of datapoint credits you’ll need to 
build your map.

FactLook pricing is based on the use of datapoints: 
a single datapoint is equal to a single visible element 
on a map. That element could be a county, state, ZIP 
code, census tract or even a specific street address 
(GeoCoding). Every monthly plan comes with an 
allowance of datapoint credits. It takes one datapoint 
credit to build one feature on your map.

For example, let’s say you have a spreadsheet with 
a single column of data for the number of people 
bitten by dogs in every county in the state of Texas. 
Texas has 254 counties and you have 254 rows of 
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data — a value for each of those counties. You will 
need 254 datapoint credits to build your map.

If you are building a map with less than 1000 rows of 
data, you most likely will want to choose the Basic 
plan. If you will be building multiple maps with many 
thousands of rows of data, you may want to look at 
the Standard or Pro plans which offer larger datapoint 
credit allowances.

Purchasing Additional Datapoint Credits

In the event you exceed your monthly plan’s allotment 
of datapoint credits, the FactLook wizard will alert you 
that additional credits are required to continue. Follow 
the prompts for purchasing additional credits.

Credits are sold in packages of 2,000 for $10. 
Unused credits will rollover to the next month.

Datapoint credit cost is subject to change per the 
FactLook terms of use, which can be found here: 
http://factlook.com/terms.html.

Introduction (continued)
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- STATES
- COUNTIES

Alphabetical (Alabama, Alaska, Arizona, etc.)

- ZIP CODES
- CENSUS TRACTS
- CONGRESSIONAL DISTRICTS

Sequential (40205, 40206, 40225, etc.)

- LOCATION / STREET ADDRESS
- LOCATION /  LATITUDE, LONGITUDE
- CUSTOM AREA

N/A, as blank grid is displayed and data will be 
pasted into first and only cell

Table 2.1: FACTLOOK WIZARD: Geo-Label Default Layout
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3. Apply styles.

FactLook lets you adjust data breaks (the number of 
groups the overall data range is divided into) colors, 
borders and opacity settings, customize legends and 
other elements to make your map look just the way 
you want it.

Formatting your Data

As previously mentioned, it’s important that your 
spreadsheet data is formatted to match the layout 
of the FactLook data grid.

For example, let’s say you are going to build a map 
displaying data for all 50 U.S. states. The FactLook 
wizard displays the U.S. states in alphabetical order. If 
your spreadsheet is not organized alphabetically, the 
data you paste in will not be matched with the alpha-
ordered states in the FactLook data grid.

The following table shows the default organization of 
geo-labels in the wizard:

Overview

Process

Building a thematic map in FactLook couldn’t be 
easier. Below are the basic steps. Details on how to 
complete each step begin on page 7.

1. Choose the geographic settings for the base layer 
of your map. 

Your options include: U.S. states, counties, ZIP 
codes, congressional districts, census tracts, street 
addresses, latitude / longitude coordinates, and 
custom areas.

2. Copy and paste data from your spreadsheet into 
the FactLook wizard.

A basic understanding of how spreadsheet programs 
work is important. You’ll want to make sure your 
data is formatted to match the data grid settings in 
FactLook. Then, simply copy the data cells from your 
spreadsheet and paste into the FactLook data grid. 
Select “Finish” to generate the base layer map and 
first geographic layer.
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3. View all of your datasets.

A dataset is a collection of values you have brought 
to FactLook from a spreadsheet or by entering them 
manually. FactLook saves your datasets so you can 
re-use them in future maps. Re-using saved datasets 
does not affect your monthly datapoint credit balance.

4. View and change your account settings.

Go to Settings to change your password and view 
your datapoint credit balance.

See “Account Settings” section on page 28 for more 
information on changing your account settings.

The FactLook Dashboard – Overview

After signing into FactLook, you will land at your 
FactLook dashboard. The dashboard is a centralized 
workspace where you can quickly view the maps and 
datasets you recently worked on. 

1. Create new maps.

Create a new map by selecting the “+” icon beneath 
My Maps or by selecting Maps from the top nav and 
then choosing File > New.

2. View all of your maps.

To view all of the maps you’ve created listed in 
chronological order, select “Maps” from the top nav.

Overview (continued)

FactLook User Interface: Key elements
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Creating a New Map

From the FactLook dashboard, create a new map 
by selecting the “+” icon beneath My Maps or by 
selecting Maps from the top nav and then choosing 
File > New.

1. Give your new map a name.

We recommend using a name that’s descriptive of the 
data and geography being shown (e.g., Dog Bites, 
Alabama - County.)

2. Select geography type.

This selection will establish your map’s base 
geography layer. The geography type you’ll want 
to choose is dependent upon the data you want to 
display. If, for example, your data is general population 
for multiple U.S. states then you will choose the State 
geography type. If you data is for counties within one 
or more states, you will choose the County geography 
type. The available geography types in the FactLook 
wizard are:

• U.S. States

• U.S. Counties

• U.S. Census Tracts

• ZIP Codes

• U.S. Congressional Districts

• Location / Street Address

• Custom Area (based on multiple geographies)

• Location / Latitude, Longitude

3. Narrow geography type.

You’ll now be asked to refine your choice of geography 
type. Again, this choice is primarily based on the data 
you want to display on the map. 

The chart on the following page shows your path 
through the FactLook wizard based on your selection 
of geography type. In the main portion of the wizard, 
the paths are similar except for the the Location / 
Street Address, Location / Latitude, Longitude and 
Custom Area geography types. Use the top left check 
box to select all options within a geography type.

Creating a Map

FactLook Wizard: Select geography type
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U.S. STATES 1. Select all or any combination of states.
2. Paste data from spreadsheet into FactLook wizard (value column).

U.S. COUNTIES

1. Select the state or states in which the counties are located.
2. From the state(s) selected, indicate which counties you want to display.
3. Choose all or any combination of individual counties.
4. Paste data from spreadsheet into FactLook wizard (value column).

U.S. CENSUS TRACTS 1. Select the state or states in which the census tracts are located.
2. From the state(s) selected, indicate which counties you want to select 

census tracts.
3. Choose all or any combination of individual census tracts within your 

chosen counties.
4. Paste data from spreadsheet into FactLook wizard (value column).

U.S. ZIP CODES 1. Select the state or states in which the ZIP codes are located.
2. From the state(s) selected, indicate which ZIP codes you want to display.
3. Choose all or any combination of individual ZIP codes.
4. Paste data from spreadsheet into FactLook wizard (value column).

U.S. CONGRESSIONAL DISTRICTS 1. Select the state or states in which the congressional districts are located.
2. From the state(s) selected, indicate which congressional districts you want 

to display.
3. Choose all or any combination of individual congressional districts.
4. Paste data from spreadsheet into FactLook wizard (value column).

LOCATION / STREET ADDRESS 1. After selecting “Location / Street Address”, you will see a blank 
data grid.

2. Paste the raw data from your spreadsheet into the first cell for each location 
you would like to see on the map (divided into street, city, state, zip columns).

3. Include any column headers or labels from your spreadsheet, as these can be 
used later to identify certain required values.

4. Paste data from spreadsheet into FactLook wizard (blank cell “A”).
5. Set Required Values for unique identifier for each location, along with 

address info and initial metric to be applied to each marker on the map.
6. After validation screen, click “Finish” to see the results on the map.

Table 2.2: FACTLOOK WIZARD: Paths and Steps Required – (for all geographies, using the top left check box 
for the column selects “all” within a category: states, counties, census tracts, etc.)

(chart continued on next page)

8

Creating a Map (continued)
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LOCATION / LATITUDE, LONGITUDE 1. After selecting “Location / Latitude, Longitude”, you will see a blank 
data grid.

2. Paste the raw data from your spreadsheet into the first cell for each location 
you would like to see on the map (divided into latitude / longitude columns).

3. Include any column headers or labels from your spreadsheet, as these can be 
used later to identify certain required values.

4. Paste data from spreadsheet into FactLook wizard (blank cell “A”).
5. Set Required Values for unique identifier for each location, along with latitude 

/ longitude info and initial metric to be applied to each marker on the map.
6. After validation screen, click “Finish” to see the results on the map.

CUSTOM AREA 1. After selecting “Custom Area”, you will see a blank data grid.
2. Paste raw data from your spreadsheet into the first cell for all geography 

shapes you would like to see on the map (must be within same geography 
type / ex: counties, zip codes, etc).

3. Include any column headers or labels from your spreadsheet, as these can be 
used later to identify certain required values.

4. Paste data from spreadsheet into FactLook wizard (blank cell “A”).
5. Set Required Values for geography type, GeoID for the shape reference, and 

initial metric to be applied to the shapes on the map.
6. After validation screen, click “Finish” to see the custom area defined on the map.

Table 2.2: FACTLOOK WIZARD (continued): Paths and Steps Required – (for all geographies, using the top left 
check box for the column selects “all” within a category: states, counties, census tracts, etc.)

9

Required Values screen for Location / Street Address selection (Key Field identifies each location)



©2016 FactLook, LLC. All rights reserved.10

Required Values screen for Location / Latitude, Longitude selection (Key Field identifies each location)

Required Values screen for Custom Area selection (GeoID field defines shapes)

See “Advanced Features: GeoCoding and Custom Areas” on page 18 for more info regarding these Required 
Values settings and definitions.

Creating a Map (continued)

You must set the initial metric value (numeric values only) column in order to proceed with the map creation process.
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Entering Data

FactLook offers two ways of entering your data for 
display in a thematic map.

1. Copy and Paste from a spreadsheet 
    (recommended method)

2. Enter manually into the FactLook table display

Both options become available in the creation of a 
new map once you have selected the Geography Type 
and further refined your selection.

Before copying and pasting data from a spreadsheet 
into the FactLook table display, first check that your 
data is formatted so that your rows of data match the 
layout of the geography types in the FactLook data 
grid. (See page 5 of this guide for more info.)

1. Copy the values you wish to display from your 
spreadsheet by selecting the entire column of data (do 
not include the column headers from the spreadsheet 
for basic geography templates; do include them 
on  Location and Custom Area templates) and then 
choosing Copy.

2. In the FactLook data grid display, click the first cell 
in the column “Value” and paste your data using either  
“Command+V” on Mac or “Control+V” on PC. Your 
data should automatically display in the Value column.

To manually enter data, simply click inside the first cell 
beneath the Value column in the FactLook data grid 
display and type your first data value. Continue down 
the column, typing your values in the succeeding cells. 

When you have finished entering data, select “Finish” 
for the FactLook wizard to create your map. By 
default, the style settings are set to the following: 

• Data breaks: 4

• Color scheme: Blue

• Break by: Equal size data ranges

• Default marker: Circle (for GeoCoded 
   location-based layers only)

Map View

You’ll arrive at the Map View after having entered data 
in the creation of a new map (using the wizard and 
clicking “Finish”), or by having opened a previously-
created map from your dashboard.

There are several features accessible through the Map 
View that are important to understand. These features 
will allow you access to controls for changing the 
appearance of your map, changing or editing data, 
adding additional datasets, renaming your map, and 
more (see image on next page).

Creating a Map (continued)

Example of default settings generated when creating a new map
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1. Map

This dominant image in the center of the Map View is 
the map generated from the selections you made and 
the data you provided. Use the +/- control in the upper 
left corner to zoom the view in or out. You may also 
zoom in by double-clicking on the map itself.

2. Map Structure

The Map Structure is a hierarchical rendering of the 
elements being used in the creation of the map. In 
the example above, the map has three datasets and 
one layer associated with each dataset (datasets can 
have multiple layers). You may access each of these 
elements and switch between them by simply clicking 
on the name (Map, Dataset or Layer).

a. Dataset: The dataset is the raw data you entered 
into the FactLook data grid. To access that data at 
any time, click on the word Dataset. If you will be 
using this dataset in the creation of additional maps 
we recommend changing the name of the dataset to a 
descriptive name that will be easier to reference later.

b. Layer: The layer contains the style properties for 
the data and geographies (color, border width, opacity 
settings, etc.) associated with this map. To change 
those properties, click on the word “Layer” to see the 
layer settings screen.

3. Navigation

The top-level navigation provides access to several 
functions associated with the current map being 
displayed, as well as offering shortcuts to building 
new and viewing previously-created maps.

FactLook Map View — Features and Functions

Creating a Map (continued)
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a. File: 

1. New: Use to create a New Map.

2. Open: Open a previously created map.

3. Save: Save changes to the current map.

4. Save Image: Saves a .PNG file of the current Map 
View to your device.

b. Add:

1. New Dataset: Your maps can contain an unlimited 
number of datasets. Use this option to add another 
dataset and layer to the current map.

2. Existing Dataset: Add a previously-created dataset 
to the current map.

3. New Layer for Dataset (menu item is active with a 
dataset selected in Map Structure): Datasets can be 
filtered to create additional layers for that dataset.	

For example, say you have pasted in data for 
population count in California, Oregon, and Nevada by 
their counties. You could then select the dataset and 
filter the results to show only the data for California 
counties by using the drop-down sorting tool seen 
above each column. Click “OK” to filter the data 
and then add a new layer for the dataset based on 
this selection of California counties (See following 
images for example).

4. Metric Configuration (active with a layer selected 
in Map Structure): By default, each shape or location 
marker has one metric assigned to it. Multiple metrics 
can be applied to shapes or markers by adding a new 
metric configuration within the layer settings screen. 
Note: the geometric shape setting for markers works 
best with a single metric, and the bar chart setting 
works best when multiple metrics are being displayed.

a. Remove:

1. Dataset (active with a dataset selected in Map 
Structure): Select the dataset(s) you wish to delete.

2. Layer (active with a layer selected in Map Structure): 
Select the layers(s) you wish to delete.

3. Metric Configuration (active with a property set tab 
selected within the layer settings screen): Select the 
metric configuration(s) you wish to delete.

a. View:

1. Structure: turn the map structure on/off within the 
overall user interface.

2. Legends: turn the legend(s) on/off within the overall 
user interface.

Creating a Map (continued)

Filtering a dataset

Adding layer for dataset based on filter
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Changing the map name within map view

Layers control on map view

Sample legend display

14

Creating a Map (continued)

4. Map Name

This is the name you gave the map in the first step 
of the map creation wizard process. You may change 
it at any time by clicking on the Map Name, entering 
the new name, and clicking return or enter on your 
keyboard. Note: when entering text into any field in 
FactLook, clicking return or enter will save the change 
and toggle to the next field.

5. Layers Control Button

Click the Layers Control to view all of the layers being 
used in the Map View. You may selectively turn on and 
off layers to change how the map is displayed.

6. Legend Display

The Legend Display contains the map legends for 
each layer, as defined on the layer settings screen(s). 
Maps with multiple datasets and layers will display 
multiple legends. To change the number of breaks, 
colors, and the legend title, select the respective layer 
from the Map Structure (#2). Legend data text can 
be defined by either manually entering the text under 
the break settings on the layer screen, or by using 
the Break Legend Text Template tool under Metrics. 
Legends can also be turned off within each layer 
settings screen.
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3. Break Legend Text Template: This tool can be 
used to change all the legend text across the breaks. 
By default, the legend text uses the minimum and 
maximum values for each break. For example: if you 
wanted to add “$” before the minimum and maximum 
values in the legend, simply enter “$” in the break 
format field before the “{min}” and “{max}” text to see 
the change reflected below in the Breaks section for 
the Legend Text.

4. Color Scheme: Color is used to provide visual 
information about the data on display. The FactLook 
wizard pairs data breaks with shades of color, and 
these are then displayed in the legend. There are three 
standard color schemes: Green, Red and Blue. These 
colors may be changed to non-standard colors in the 
Fill Color setting in the Breaks section.

5. Show Metric Legend: ON by default, deselect to 
hide the legend associated with this specific layer. You 
may also provide a Legend Title in the space provided.

Using your data, the FactLook wizard automatically 
generates a map using default settings to display 
certain key visual elements. (see Table 3.1: Layer 
Defaults & Options on page 18 for a list of defaults 
and available options.)

If you would like to customize those options, click on 
any layer in the Map Structure. The options governing 
the display of your map and data values are bundled 
under three sections: General, Property Style Sets 
and Breaks.

a. General

1. Name: Change the name of the layer here.

2. Marker Type: Choose the type of marker to be used 
for Specifc Address layers.

3. Filter: If you have filtered any datasets to create 
additional layers (see page 13 of this manual), the 
parameters of the filter will be displayed here.

4. Enable Legends: This is ON by default. Deselect to 
hide the legends associated with a layer used in this 
map. A quick way to address legends and markers 
that contain mulitple metrics.

b. Metrics

1. Metric Source: The “metric source” is the identifier 
telling the FactLook wizard which data to use to 
create breaks or plot specific locations. If a layer is set 
to display multiple metrics/property sets, they will be 
displayed here as tabs.

2. Number of Breaks: The FactLook wizard 
automatically groups your data into subsets called 
breaks. The default setting is four breaks. You may 
change this setting to any number. Also, see “Break 
By” description in item #6.

Min/Max values for the number of data breaks can 
be adjusted manually

Legend settings

Changing the Appearance of your Map



©2016 FactLook, LLC. All rights reserved.16

6. Break By: By default, this is set to “Equal Size Data 
Ranges”, which sets equal gaps between the data 
breaks. This can be changed to “Equal Size Groups”, 
which assigns the data into equal sized groups on 
the map, which typically produces a more visually 
balanced-looking map (see example below).

FactLook has two break calculation methods for 
distributing the raw data. “Equal Size Data Ranges” 
distributes the raw data across the number of breaks 
with an equal range between (ex: the 35 to 44 years 
old population data values for the map range from 74 
to 287,782 per county, so 287,782 - 74 = 287,708 ÷ 4 
breaks = 71,927 range for each break).

As most county population numbers in Nevada fall 
into the first break using this method, this creates a 
more visually flat map (mostly light green, only one 
darker shape representng Clark County).

“Equal Size Groups” takes the raw data and distributes 
into equal sized groups for the map (ex: 17 datapoints 
for 17 counties in Nevada ÷ 4 breaks = 4.25 counties 
for each shade of green). The first three breaks are 
assigned 4 counties and the last break 5 counties.

Equal Size Data Ranges vs Equal Size Groups for data breaks

Changing the Appearance of your Map (continued)
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c. Breaks

The Breaks panel contains a variety of controls to 
further refine how data values are visually presented 
on the map.

1. Legend Text: The FactLook wizard will present the 
numerical data ranges associated with each break 
in the map legend. You may change those ranges to 
any combination of letters or numbers. Use the Break 
Legend Text Template tool to quickly standardize 
formatting across all the legend text.

2. Decimal Points: If the data you pasted into the 
FactLook wizard for this layer included decimal points, 
you can change the settings in this row to display them 
in the Legend. To do so, enter the number of digits 
to be displayed to the right of the decimal point. “1” 
will show one number, “2” will display two numbers 
and so on.

3. Number of Datapoints: When break by has been set 
to Equal Size Groups, the FactLook wizard displays 
the number of datapoints assigned to each break. 
These value cannot be adjusted.

4. Minimum Value / Maximum Value: When “Break 
By” has been set to Equal Size Data Ranges, the 
FactLook wizard automatically determines the size 
of each break. It then scans each break to determine 
the lowest numerical value as well as the highest 
numerical value. Using the Include Minimum Value 
and Maximum Value controls, you can decide where 
the minimum and maximum values fall within the 
breaks (by default the overall maximim value in the 
data range must fall in the last break).

5. Fill Color: When using any of the FactLook standard 
Color Schemes (Green, Red or Blue), the FactLook 
wizard will assign a number of shades (depending on 
the number of data breaks) of the selected color to 
each of the breaks. You may change these colors by 
clicking on the cell. A pop-up window will display from 
which you may choose from a color swatch palette or 
by entering a new hexadecimal color code.

6. Fill Opacity: Lowering the Fill Opacity setting will 
result in more of the map’s base layer being visible. A 
higher Fill Opacity setting will increase the amount of 
color displayed in the geographic unit.

7. Border Width: the Border Width for each break may 
be set separately. The higher the number used in the 
Border Width setting, the thicker the border.

8. Border Color: Just as with Fill Color, the border 
color is controlled via a pop-up window that offers a 
color palette picker. The default Border Color is black.

9. Border Opacity: The default 100% Border Opacity 
presents as a solid border. Lower the value to make 
the border less visible.

10. Show Border: Deselect this option to hide the 
border associated with one or more breaks.

11. Radius (location-based layers only): Set the 
size of the marker used for representing GeoCoded 
addresses. Larger the number, the larger size of 
the marker.

12. Number of sides (location-based layers only): 
Choose the number of sides for markers, to determine 
what shape it is. 60 = circle, as default.

13. Bar Width (location-based layers only): Set the 
size of individual bars within the marker charts.

14. Chart Max Height (location-based layers only): Set 
the overall size of the marker charts.

Fill color and opacity settings

Changing the Appearance of your Map (continued)
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SETTING DEFAULT OTHER OPTIONS

METRICS

COLOR SCHEME Blue Green, Red

SHOW METRIC LEGEND On Off

NUMBER OF BREAKS 4 User Defined

BREAK LEGEND TEXT TEMPLATE {minimum} - {maximum} User Defined

BREAK BY Equal Size Data Ranges Equal Size Groups

SETTING DEFAULT OTHER OPTIONS

BREAKS

DECIMAL POINTS 0 User Defined

FILL COLOR Blue (Red or Green) Shades User Defined

FILL OPACITY 75% 0 - 100%

BORDER WIDTH 1 1 - 100

BORDER COLOR Black User Defined

BORDER OPACITY 100% 0 - 100%

SHOW BORDER On Off

RADIUS 10 1 - 100

NUMBER OF SIDES 60 (circle) 3 - 60

BAR WIDTH 10 10 - 100

CHART MAX HEIGHT 10 10 - 100

Table 3.1: Default layer settings and user defined options

18

Changing the Appearance of your Map (continued)
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Copy all cells of data from spreadsheet

Geography type for geocoding

19

Advanced Features: Geocoding and Custom Areas

a. Intro to Geocoding

FactLook allows you to “pin” specific locations using 
street addresses or latitude/longitude coordinates to 
your map. This feature, called Geocoding, can be used 
to identify your organization’s retail store or business 
office locations, state capitals or courthouses, 
airports, transportation hubs or myriad other address-
specific data. FactLook’s Geocoding feature is simple 
to use but does require the user to pre-format your 
data before pasting it into the FactLook wizard.

Location / Street Address

1. Format your spreadsheet:

When Geocoding with FactLook, your spreadsheet 
must be formatted to include the following columns of 
data for each location to be plotted on the map. 

• A unique Key Field ID (this is assigned to each 
marker when placed on the map) 

• Street Address (for location) 

• City (for location) 

• State (for location) 

• ZIP code (for location)

• Initial metric value (numeric value assigned to 
each marker, required for determining data break 
calculation)

Be sure to create a header row using the above labels 
for each of the columns.

Sample spreadsheet showing column headers

Here’s an example of a spreadsheet that’s been 
formatted for FactLook Geocoding:

2. Copy the addresses and header row

After formatting your data, you’ll need to select the 
addresses you wish to pin to your map as well as the 
header row (the row on your spreadsheet with Key, 
Street, City, etc.)

3. Create Map or Add Dataset to Existing Map

If you have not yet created the map to which you wish 
to pin the addresses you copied in step 2, do so now. 

a. From the Dashboard: Select “+ Create a New Map”. 

b. Give your map a name: Enter a name for your map 
in the appropriate field and provide a brief description 
if desired. Click Next.

c. Select geography type: Choose Location / Street 
Address. Click Next.
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Select cell below “A” header in data grid

Paste data, including column headers

Required values to set up geocoding
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Advanced Features: Geocoding and Custom Areas (continued)

d. Selected Location / Street Address geographies: 
Place cursor in the cell beneath the “A” column header.

e. Paste data: Paste data into the FactLook Wizard. 
The header row will automatically update with 
the header row and data from your spreadsheet. 
Click Next.

f. Select columns to use for required values: Help 
the FactLook Wizard identify which columns of data 
to use in order to place your pins. Click Next to view 
your map.

Sample spreadsheet formatted correctly

Copy all cells (including headers)

Location / Latitude, Longitude

1. You can also create a map using the latitude and 
longitude coordinates of one or several locations. To 
do so you will need valid coordinates for each location 
you wish to pin on the map. Here is a sample of a 
spreadsheet which has been formatted correctly:

2. Copy the locations and header rows:

After formatting your spreadsheet, select the rows of 
cells cells containing the locations — including the 
header row — you want to display on your map, as in 
the example below.
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Select geography type

Set required values
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Advanced Features: Geocoding and Custom Areas (continued)

3. Create map or add dataset to existing map 

If you have not yet created a map, or having created 
a map you wish to add these locations as a unique 
dataset, do so now

By creating a new map:

a. From the Dashboard: Select “+ Create a New Map”. 

b. Give your map a name: Enter a name for your map 
in the appropriate field and provide a brief description 
if desired. Click Next. 

c. Select geography type: Location / Latitude, 
Longitude Map. 

d. Click Next.

By adding a new dataset:

a. From the Map view, select Add > New Dataset

b. Give your dataset a name and provide a brief 
description if desired. Click Next. 

c. Select geography type: Location / Latitude, 
Longitude Map. 

d. Click Next.

Paste raw data into FactLook data grid

e. Paste data: Paste data into the FactLook Wizard. 
The header row will automatically update with the 
header row and data from your spreadsheet. 

f. Click Next.

g. Select columns to use for required values: Help the 
FactLook Wizard identify which columns of data to 
use in order to place your pins.

h. Click Next to view your map.
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Changing marker geometric shape

Changing marker size, relative to other markers

Default settings for geocoded markers

Changing default fill color settings
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Advanced Features: Geocoding and Custom Areas (continued)

c. Change the default marker shape from a circle by 
changing the value of the Number of Sides. (60 = 
circle, 3 = triangle, etc.)

d. Change the size of the markers by changing the 
value of the Radius (the larger the radius, the larger 
the marker that will appear on the map). 

4. Changing the look of your geocoded markers

By default, FactLook presents your geocoded 
markers as circles in shades of blue. You may change 
the color, shape and size of the markers via options 
in the Layer settings.

a. Within the Map Structure, click the Layer settings of 
the layer you wish to configure. 

b. Change the default color using the color picker or 
by entering hexadecimal values.
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Sample spreadsheet showing three metric columns

Marker changes updated on map view

Marker changes updated on map view
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b. Working with Multiple Metrics

FactLook gives you the capability to assign multiple 
metric values to a single geocoded location which 
are then displayed on a map as fully-customizable 
bar charts.

Location / Street Address

1. Format your spreadsheet:

Format your spreadsheet in the same manner as 
when using FactLook’s geocoding feature. In addition 
to the required columns of data, you’ll want to 
include columns of the additional metric values to be 
associated with each marker.

• A unique Key Field ID (this is assigned to each 
marker when placed on the map) 

• Street Address (for location) 

• City (for location) 

• State (for location) 

• ZIP code (for location)

• Initial metric value (numeric value assigned to each 
marker, required for determining data break calculation) 

• Additional metric value(s) (the additional data you 
wish to associate with each marker)

Be sure to create a header row using the above labels 
for each of the columns.

Here’s an example of a spreadsheet that’s been 
formatted for a geocoded location with multiple 
metrics (three).

Advanced Features: Geocoding and Custom Areas (continued)

e. View changes by selecting Map: {Map Name} from 
the map structure

f. Hovering the cursor over any of the markers will 
display the key field identifier chosen on the required 
values screen. Click on any of the markers to view 
values and other details associated with each of the 
geocoded locations.
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Select cell below “A” header in data grid

Paste data, including column headers

Copy all cells of data from spreadsheet

Geography type for geocoding
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Advanced Features: Geocoding and Custom Areas (continued)

d. Selected Location / Street Address geographies: 
Place cursor in the cell beneath the “A” column 
header.

e. Paste data: Paste data into the FactLook Wizard. 
The header row will automatically update with 
the header row and data from your spreadsheet. 
Click Next.

f. Select columns to use for required values (see 
image at top of next column): Help the FactLook 
Wizard identify which columns of data to use in order 
to place your pins. Choose one of the metrics you’d 
like to display (you will add the additional metrics in 
later steps). Click Next to view your map.

2. Copy the addresses and header row

After formatting your data, you’ll need to select the 
addresses and data you want to pin to your map, 
Be sure to copy the header row (the row on your 
spreadsheet with Key, Street, City, etc.)

3. Create Map or Add Dataset to Existing Map

If you have not yet created the map to which you wish 
to pin the addresses you copied in step 2, do so now. 

a. From the Dashboard: Select “+ Create a New Map”. 

b. Give your map a name: Enter a name for your map 
in the appropriate field and provide a brief description 
if desired. Click Next.

c. Select geography type: Choose Location / Street 
Address. Click Next.
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Selecting data source for new metric 

Additional tab for new metric is added

Default settings for single metric markers

Adding another metric to marker
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b. A new window will open. From the drop down menu, 
select the additional metric value you wish to add to 
the marker. Only values that have not previously been 
added to the marker will be displayed.

c. A new tab will appear in the Metrics panel in the 
Layer view. Adjust colors and other styles for this 
metric using the selectors in the Breaks panel.

d. Add additional metrics using the same procedure 
as above. Assign a unique color palette to each metric 
set, to be displayed in the bar chart (see image at top 
of next column).

Advanced Features: Geocoding and Custom Areas (continued)

Required values to set up geocoding

4. Adding Additional Metrics

a. After clicking Next in the previous step, your 
map will display a single metric. To add additional 
metrics, from the Layer view, select “Add” > “Metric 
Configuration”.
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Multiple metric bar charts now displayed

Multiple metric bar charts now displayed

Setting unique colors for each metric

Chart width and height settings
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Advanced Features: Geocoding and Custom Areas (continued)

g. Go to Map view to see your changes.

h. Hovering the cursor over any of the bars in the 
chart will display the key field identifier chosen on the 
required values screen. Click on  bar charts to view all 
metrics associated with that marker.

Location / Latitude, Longitude

The instructions for displaying multiple metrics 
to geocoded latitude/longitude locations is the 
same as described above. The only exception is 
in the formatting of the spreadsheet. The columns 
for “Street Address”, “City”, “State” and “ZIP” are 
understandably not required. Instead, use two 
columns, Latitude and Longitude.

e. In the General panel, change the Marker Type from 
“Shape” to “Barchart”.

Marker type drop-down setting

f. In the Breaks panel, set the bar widths for each 
break and the overall chart maximum height to suit 
your preferences.



©2016 FactLook, LLC. All rights reserved. 27

a. Saving Maps

1. When working on a map: every time you select 
a dataset or layer in the Map Structure (whether to 
make changes to a layer or view data), clicking back 
on the map layer to view the map automatically saves 
your changes.

2. When viewing the map and not clicking anything in 
the Map Structure: any panning, zooming or turning 
on/off of layers will not be saved unless you click 
“Save” under the file dropdown. These changes will 
then be saved to the map file in your dashboard.

b. Printing Maps

1. When you are ready to save a map image (either 
for printing or inserting into another document, such 
as Word or PPT), set the layers on/off and adjust the 
zoom and panning to the desired look. Then click 
“Save Image” under the file dropdown UI, and a PNG 
file will be saved to your device.

Saving map and image for export

Saving, Printing and Exporting Maps

Advanced Features: Geocoding and Custom Areas (continued)

Custom shape based on ZIP codes

c. Building Custom Areas

In addition to using the Wizard to selectively choose 
which geographies to include in a particular layer, 
another way to build a custom area on your map is to 
simply paste in raw data to define the area. As long as 
each shape has a GeoID associated with it, FactLook 
will recognize the ID and include it in the area.

This can be especially useful when defining complex 
custom areas that cross state, county or other 
geographical borders. For example: ZIP codes do not 
typically adhere to state or county borders. Creating 
a custom area for 100 ZIP codes within a three state 
region would require manually selecting individual ZIP 
codes within the states using the Wizard.

By pasting in the raw data as a set and then telling 
FactLook what the GeoID for each shape is, the 
system will build the custom area for you. As a result, 
you can also specify a metric for each shape within the 
custom area while creating the layer.
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Support

GlossaryAccount Settings

The following are key terms you will encounter when 
using FactLook. You’re encouraged to familiarize 
yourself with them.

Break:

A break is a group of data within a value range that 
you can set manually or allow the FactLook  wizard to 
set for you. An example of a set of breaks is:

1 - 99

99 - 150

150 - 400

These groups or “breaks” are visibly displayed on 
your map via color or other identifier, and can be 
adjusted using the options in the layer’s Property Style 
Settings. The FactLook wizard allows you to set as 
many breaks as you want.

Datapoint:

A datapoint is a term used to describe a single visible 
element on a map. That element could be a county, 
state, ZIP code, census tract or even a specific street 
address (GeoCoding). Your monthly FactLook plan 
comes with a set number of datapoint credits; if you 
exceed that number during the course of the month, 
your account will be automatically charged for the 
overage, currently set at 0.1¢ per additional datapoint.

Datapoint Credit:

Each FactLook plan comes with a set number of 
datapoint credits. The FactLook wizard will use these 
credits to build your maps. A single credit is equal to 
a single visible feature on your map. The easiest way 
to determine how many datapoint credits it will take to 
build you map is to count the number of rows of data 
that you will be copying from your spreadsheet and 
pasting into the FactLook wizard.

FactLook customer support is available for questions 
about billing, problems accessing your account and 
technical issues.

For help using the software, check the tutorials 
page on the blog.factlook.com website — you’ll 
find videos that address the most common 
user questions. In addition, an online version of this 
user manual is also available at blog.factlook.com. 
FAQs, a Knowledge Base and Known Issues can also 
be found there for review.

To contact FactLook support, email support@factlook.
com. A FactLook customer support specialist will 
respond to your issue within 48 hours of receiving 
your email.

You may change your password and view your 
remaining datapoint credit balance at any time by 
selecting “Settings” from the top navigation. 

Changing your password

Follow the instructions to change your password.

View Remaining Datapoint Credits

The FactLook wizard maintains a running total of 
the datapoint credit balance associated with your 
account. At the end of the 30-day billing period, a 
new allotment of datapoint credits associated with 
your plan will be added to any unused credits from 
the previous month(s). The FactLook wizard will notify 
you if a you exceed your available balance and will 
provide instructions for purchasing more datapoint 
credits, if desired.
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Glossary (continued)

Dataset:

A collection of datapoints is a dataset. The FactLook 
wizard groups datapoints into sets so that you can 
easily apply styles, breaks and other identifiers that 
help visually represent your data.

Data Source:

Your raw data to be used in FactLook to create a 
thematic map. Typically contained and formatted in 
a spreadhseet program, such as Microsoft Excel or 
Apple Numbers.

Equal Size Data Range / Equal Size Groups:

These are the two methods for creating breaks 
employed by the FactLook wizard.

Equal Size Data Ranges distributes the raw data 
across the number of breaks with an equal range 
between (ex: population data values for the map 
range from 713 to 6,318,306 per county, so 6,318,306 
- 713 = 6,317,593 ÷ 4 breaks = 1,579,398 range for 
each break).

Equal Size Groups takes the raw data and distributes 
into equal sized groups for the map (ex: 58 datapoints 
for 58 counties in CA ÷ 4 breaks = 14.5 counties 
for each shade of blue). The first three breaks are 
assigned 14 counties and the last break 16 counties.

Fill Opacity:

Each shape displayed on a map has the transparency 
set through the use of the fill opacity control. Set this 
value from 0 to 100%, to determine how much of the 
underlying layers are visible.

Geocoding:

The process of transforming a description of a location 
(such as an address, name of a place, or coordinates) 
to a location on the earth’s surface. Geocoding 
typically refers to the transformation process of 
addresses and places to coordinates.

Hex Values for Color Picker:

When using the color picker to set your colors for fill 
and border, the hexadecimal color system may be 
used for exact color matching. If you are not familiar 
with the hex system, then simply choosing one of the 
preset swatches should be sufficient.

Map Structure:

The FactLook Map Structure defines how your map is 
presented. Your raw data is used to create datasets, 
which can contain any number of layers. Layers are 
then styled using the settings screen, which creates 
the look of your map.

Metric:

A metric can be attached to each shape or marker 
displayed on the map. Metrics come from your raw 
data source and are defined when setting up the 
dataset and layer using the wizard.

Thematic Map:

A customized map built on the concept of associating 
raw data with either geographic shapes or GeoCoded 
markers for specific addresses.


